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SCC-A010 Isolated Analog
Output Module

The SCC-AO10 is an isolated voltage output module with an output range
of £10 V. The output voltage level is controlled by the DAC output of an
E/M Series DAQ device. You can increase the output voltage level to
120 V by connecting two SCC-AO10 modules in series.

Conventions

The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

> &

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

ﬁ When symbol is marked on a product it denotes a warning advising you to
take precautions to avoid electrical shock.
é When symbol is marked on a product it denotes a component that may be
hot. Touching this component may result in bodily injury.
bold Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.
italic Italic text denotes variables, emphasis, a cross reference, an introduction

to a key concept, or text as it appears on a hardware label. Italic text also
denotes text that is a placeholder for a word or value that you must supply.
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monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345 SC-2345 refers to both the SC-2345 connector block and the SC-2345 with
configurable connectors.

SCC SCC refers to any SCC Series signal conditioning module.

What You Need to Get Started

To set up and use the SCC-AO10, you need the following items:

U Hardware

SC-2345/2350 with one of the following:
*  SCC-PWRO1
e SCC-PWRO02 and the PSO1 power supply

e SCC-PWRO03 (requires a 7 to 42 VDC power supply,
not included)

One or more SCC-AO10
68-pin E/M Series DAQ device
68-pin cable

Quick Reference Label

U Software

The latest version of NI-DAQmx

U Documentation

SCC-AO010 Isolated Analog Output Module User Guide
SC-2345/2350 User Manual

SCC Quick Start Guide

Read Me First: Safety and Radio-Frequency Interference
Documentation for your hardware

Documentation for your software

U Tools

1/8 in. flathead screwdriver
Numbers 1 and 2 Phillips screwdrivers

Wire insulation stripper
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E Note Software scaling of measurements is not supported on the Macintosh operating
system. Refer to the SCC-AO10 Connector Pin Assignments section.

You can download NI documents from ni . com/manuals. To download
the latest version of NI-DAQmzx, click Download Software at ni . com.

Device Specific Information

@ Note For general SCC module installation and signal connection information, and
information about the SC-2345/2350 carrier, refer to the SCC Quick Start Guide, available
for download at ni . com/manuals.

Installing the SCC-A010

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

Plug the SCC-AO10 into either SC-2345/2350 analog output socket
J(X+17), where X is 0 or 1. The SC-2345/2350 routes the voltage output of
E/M Series DAQ device analog output channel AO (X) to the SCC-AO10.

Connecting the SCC-A010 to a Load

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

@ Note The signal names have changed. Refer to ni.com/info and enter rdtntg to
confirm the signal names.

The SCC-AOI10 has a three-pin screw-terminal connector that accepts
28 to 16 AWG wires.

The screw terminals are labeled by pin numbers 1 to 3. Pin 1 is the isolated

ground. Pins 2 and 3 both connect to the isolated voltage output for
flexibility in field wiring.

A Caution Connecting an external voltage source to the output terminals of the SCC-AO10
may damage the module.

Figures 1 and 2 show the SCC-AO10 connected to a nonreferenced load
and to a load with a high common-mode voltage.
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E/M Series
DAQ Device SCC-AO10

AO (X)
2 Load
AO GND

Figure 1. SCC-AQ10 Connected to a Nonreferenced Load

E/M Series
DAQ Device SCC-AO10

AO (X)

Load

AO GND

¢ L
7

Figure 2. SCC-A010 Connected to a Load with a High Common-Mode Voltage

Connecting Two SCC-AO010 Modules in Series

You can increase the maximum total output voltage to 20 V by
connecting two SCC-AO10 modules in series. Plug the two modules into
sockets J17 and J18 of the SC-2345/2350, and wire the modules to a load
as shown in Figure 3.
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E/M Series
DAQ Device  SCC-AO10 in Socket J18
3
AO 1 N
2
Vourz +
AO GND -
1
VOutTota/
SCC-AO10 in Socket J17
3
AOO ) 4 Load
Vourt -
AO GND -
1

Figure 3. Connecting Two SCC-AQ10 Modules in Series

The SC-2345/2350 routes the E/M Series DAQ device analog output
channels AO 0 and AO 1 to the SCC-AO10 modules, and the resulting
maximum output voltage range is £20 V. Refer to Figure 3 and use the
following formula to calculate the total output voltage from both
SCC-AO10 modules:

Vourtotat = Vouri + Vour

where
Voutow 18 the total output voltage from both SCC-AO10 modules

Vours 1s the voltage across terminals 1 and 3 of the SCC-AO10
module in socket J17

Vour 1s the voltage across terminals 1 and 3 of the SCC-AO10
module in socket J18

For information about how to configure the SCC-AO10 module with
NI-DAQmzx, refer to the SCC Quick Start Guide.
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Using the SCC-A010

This section contains information regarding scaling voltage measurements
and isolated ground references.

Scaling Voltage Measurements

The SCC-AO10 is a £10 V isolated analog output module. The output
voltage is controlled by an E/M Series DAQ device AO output channel,
AO (X). The relationship between the AO (X) voltage level and the output
voltage level of the SCC-AO10 is a one-to-one linear relationship. That is,

VAO(X) = Viouo

where
Vao (x) is the AO 0 voltage level
Vo1 1s the SCC-AO10 voltage output in volts

Isolated Ground Reference

Each SCC-AO10 module is referenced to its own isolated ground. Each
isolated ground can have up to 60 VDC of common-mode voltage between
itself and any other channel ground or chassis ground. Refer to the
Connecting the SCC-AO10 to a Load section for ways to use the isolated
ground in signal connections.

Calibrating Gain and Offset Errors

The SCC-AO10 is calibrated at the factory before shipment. To adjust the
gain and offset of the SCC-AO10 in your system using an E/M Series DAQ
device, you need a voltage meter and a 1/8 in. flathead screwdriver. Before
adjusting the SCC-AO10, allow 30 minutes for the DAQ device to warm
up to its nominal operating temperature.

To adjust the gain and offset of the SCC-AO10, complete the following
steps:

1. Disconnect the load from the SCC-AO10 you want to calibrate.

2. Set an output range of —10 to +10 V for AO (X), the E/M Series DAQ
device channel connected to the SCC-AO10.

3. Connect the negative lead of the voltmeter to the isolated ground
terminal (pin 1) and the positive lead to the voltage output terminal
(pin 2 or 3) of the SCC-AO10.

4. Using your software, set AO (X) to output O VDC.
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5. Adjust the offset potentiometer on the top of the SCC-AO10 until the
voltmeter reads 0 VDC £100 pV. The offset is now calibrated.

6. Using your software, have AO (X) output 9.9 VDC.

Adjust the gain potentiometer on the top of the SCC-AO10 until the
voltmeter reads 9.9 VDC. The gain is now calibrated.

Specifications

These ratings are typical at 25 °C unless otherwise stated.

Electrical
Number of output channels.................... One nonreferenced (floating)
Input range ......cocceevvvvieenieeieenieeeeen 10V
OUutput TANZE....couveeveirieeeieeieenieeeeaeeen 10V
Current drive ......c.cceeeeeveeevenencneeennenn +30 mA
Gain nonlinearity.........c..cccceeeeeencreennens 0.5% of full-scale output range
OULPUL NOISE -t 2.5 mV s typ; 4 mV . max
Bandwidth .......cccccoeiiiiiiininiinien >23 kHz
SIEW Tate....cc.eocveeiieieiieicieeeee e 1 V/us

Short circuit protection

CUITENL ... 37 mA max
Duration ........ccoeeevveeeievvneeeeeeeeeenn. Unlimited
Load impedance ..........ccccceeevenerneenncnne. 10,000 pF max
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Power Requirement

ANalog POWET ...c..oveenuineeiinieeienienieniene 180 mW max at full load
172 mW max with no load
FISV o 6 mA max at full load
5.73 mA max with no load
15V e 6 mA max at full load
5.73 mA max with no load
Digital power (+5 V) ..cocevieeinieiincenns 1.15 W max at full load
600 mW max with no load
F5V e 230 mA max

120 mA max with no load

Physical
1.87 cm

1 (074|n) [ 793 cm !

- > < (3.12in.) >
- T
L 3.55cm
L (1.41in.)

Figure 4. SCC-A010 Dimensions

Weight ..o 28 g (1.0 0z)

I/O conNEctors.......cccevueeueenuereenienieeienienne One 20-pin right-angle male
connector; one 3-pin screw
terminal

Field-wiring diameter ...........cccceevveeuenne 28to 16 AWG
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Maximum Working Voltage

(Signal + common-mode) each input should remain within 42.4 V., or
60 VDC of ground.

Maximum working voltage refers to the signal voltage plus the CMV.

Channel-to-earth (inputs) ..........ccccceueeee. 42.4 V eq 01 60 VDC,
Measurement Category I

A Caution This device is rated for Measurement Category I and is intended to carry signal
voltages no greater than 42.4 V., or 60 VDC. Do not use this device for connection to
signals or for measurements within Categories II, III, or I'V.

Isolation Voltage

Channel-to-earth isolation

ContinuUOUS .......cccevveeeeeecrrreeeeeenenen. 60 VDC,
Measurement Category 1
Withstand .......cccceevvenveeniiennieniennnen. 2300 V¢ verifiedby a5 s

dielectric withstand test

Environmental
Operating temperature............cocceeveeueenee. 0to50°C
Storage temperature .........ceceervveeveeenueenns -20to 70 °C
Humidity ..oooevveniiniiiiniiiiiecieces 10 to 90% RH, noncondensing
Maximum altitude .............cccevvereeeennnnen.. 2,000 m
Pollution Degree (indoor use only)........ 2
Stability
Recommended warm-up time................. 10 min (30 min for connected

E/M Series DAQ device)
Output offset drift.........cccceceeeineenincene. 300 uv/°C

Gain temperature coefficient.................. 300 ppm/°C
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Safety

The SCC-AO10 is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« IEC61010-1, EN 61010-1
« UL 61010-1
e CAN/CSA-C22.2 No. 61010-1

@ Note For UL and other safety certifications, refer to the product label, or visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.

Electromagnetic Compatibility

EmiSSions.....c..eeeeeeiiuveeeeeeiiieeeeeeeiveeeeeenns EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

IMmMUNity ...oocooeeeieieeeeeeeeeee e EN 61326:1997 + A2:2001,
Table 1

EMC/EMI ...ccooovviiiiiiiiiiiiiieiieeieeeeeen CE, C-Tick, and FCC Part 15
(Class A) Compliant

@ Note For EMC compliance, operate this device with shielded cabling.

CE Compliance
The SCC-AO10 meets the essential requirements of applicable European

Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety).............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMOC) ...cccovevvvcvvenininencnnnee 89/336/EEC

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.
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SCC-A010 Connector Pin Assignments

Figure 5 shows the I/O connector pins on the bottom of the SCC-AO10.

/@

000000000
0000000000 @
1 Pin1 2 Pin2 3 PWB Key 4 Pin19 5 Pin 20

Figure 5. SCC Module Bottom View
Table 1 lists the signal connection corresponding to each pin.

Table 1. SCC-AQ10 I/0 Connector Signal Assignments

Pin Number Signal
1 E/M Series AO (X)
2 E/M Series AO GND
3 —
4 E/M Series AO GND
5 —
6 —
7 —
8 —
9 +5V
10 GND
11 —
12 + 5 V reference
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Table 1. SCC-A010 I/0 Connector Signal Assignments (Continued)

Pin Number Signal
13 +15V
14 -15V
15¢ —
16 —
17 —
18 —
19 —
20 —
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.
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